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Impress you with flash flipping pages, beautiful external and

customized functional settings!
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AboutAboutAboutAbout ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog totototo FlippingFlippingFlippingFlipping BookBookBookBook

Shopping Catalog to Flipping Book is an amazing
page-turn converter which can publish
virtual shopping catalog with flash flipping page.
With this book flip software, you can edit
the flipping pages with multimedia and other
functional buttons, which can help you to turn the
PDF catalogs into interactive sales tools. Insert
dynamic price buttons, links to the electronic
flipping book catalogue. Automatically generate
the command line mode.

Note: This product is based on a "Try before-you-buy" principle. All

features mentioned in this instrument can be realized. Once you

bought the software, you would get a unique register, and the

registered version doesn't insert our watermark in your generated

page flipping catalogs.
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ProductProductProductProduct featuresfeaturesfeaturesfeatures

1. Convert PDF to Adobe© Flash® based digital 3D shopping catalogs with Flipping-Book-Maker

effect.

2. All pages, custom pages importing or quickly import 10 pages to initial preview.

3. Different five qualities and sizes for you to choose.

4. Importing bookmarks from original PDF files.

5. Import hyperlinks with PDF, include web link, page link, email link.

6. Import text and enable search helps your readers to write in the keyword to quickly find the

content.

7. Detecting wide pages then the book can be shown in landscape or portrait orientation pages.

8. Setting watermarks adds different text or image watermarks on pages to protect authority of your

Flipping Page book.

9. Batch convert different PDF files to a single or multiple Flipping-Book-Maker eBooks.

10. Provide command line version.

11. Detect landscape page to present as two-page spread.

12. Add watermarks text, image, dynamic date/ time etc to Flipping-Book-Maker eBooks.

13. Define quality and size for normal version and mobile version.

14. The Flipping page book you made by Shopping Catalog to Flipping Book can be output as Six

different formats:

� Html, it makes your publication can be distributed on-line or just view offline;

� Zip, it helps you to transmit your publication through the E-mail;

� Mobile version, when output book in HTML or ZIP format, you can also give a check mark to

make mobile version at the same time, which will make your page flipping ebook works on

iPad, iPhone and Android mobile devices;

� Exe, it let your publication can be used in your computer separately; Mac

� App, Application Flipping E-books form can be run on Mac;

� Burn to CD/DVD, you can choose a disk to your flip book, it will not ask for specified
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memory address.

15. Apply a pre-designed template.

16. Preview the effect before output.

17. Add HTML Title in Float template which can be clicked to visit webpage online.

18. Add Image or Flash logo to insert before Book Title in Float template.

19. Define book proportions, margin size, and shadow manually.

20. Insertions can be: links, video, picture, sound, SWF, YouTube for every Page.

21. Multi-page photo Slideshow can be embedded and pop-up to play.

22. New individualized buttons can be added.

23. Add shopping projects to pages, like Price, Order buttons, Product photos, Shopping icons, etc.

24. Add printable coupons on your page flipping eBooks to make your promotion more individual and

powerful.

25. Quick shortcut like copy and paste objects to current page and apply objects to other pages.

26. Convenient buttons Redo and Undo help you change your pages quickly.

27. Added four function buttons:

� Text: The defaulted text is "buy now" for you more convenient to sell your goods, you can

also change it;

� Price: Change the hint, price unit, price and background color, insert URL and more options

in Price button you can set;

� Pop up photos: Add URL, image,SWF and slideshow, design the action of the image.

28. Buttons from resource: pre-designed buttons for you easily insert in your flipping shopping e-book,

and you can import your own design if you wish.

29. Add new icons into toolbar with calling new actions.

30. Set background color and image.

31. Insert background music either for continuous play (loop) or for a set duration.

32. Set eBook reading from right to left (for Right-to-Left languages such as Arabic).

33. Choose hard cover for eBooks.

34. Set fonts for Flash and Bookmark, Search panel.

35. Set Page Number Box to show at top or bottom in Float, set start page number.
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36. Copy projects from one page to another or all the other pages.

37. Define the language for your published Flipping-Book-Maker eBook (support multi-language show

and switchable).

38. The Shopping Catalog to Flipping Book has four templates: Classical, Float, Spread and Neat, and

different themes in each template.

39. The font of the buttons, window, bookmarks, or search results can be different choices of you.

40. Define colors to the button icon, fonts, background, flash window, page background, and mouse

over.

41. The button icons can be changed by the SWF files only but it turns into your own icon.

42. Retain the book to center or let it be in the right side, and the left would be your instruction of the

book or warning or something else.

43. Single page or double pages present.

44. Provide Initial show with thumbnails or bookmark panel.

45. Book margin, Page shadows can be adjusted.

46. Set page number in both Roman and Arabic style to separate Table of Content pages and Body

pages.

47. Minime style lets the flipping page shopping catalog can be shown and turned in smaller window.

48. Inserting book logo and the logo URL to publicize your company or organization.

49. Naming the book title gives readers impression of your Page Flipping E-book.

50. Enable or disable home, download, sound, zoom in, auto flip and other fantastic features.

51. Embedding the content of about which including the information of the author or the book.

52. Help content files can be injected or be empty to use default help content.

53. Enable Share to allow users to share publications with others via e-mail or other medium, such as

Google, Twitter, Facebook, Yahoo, Live etc.

54. Setting a password to protect all pages or part pages of your flipping catalog.

55. Add Google Analytics Support.

56. Add watermark image or SWF to show on print out pages.

57. Export and save settings for future uses.

58. Save and Load your project.
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Flipping-Book-MakerFlipping-Book-MakerFlipping-Book-MakerFlipping-Book-Maker eBookeBookeBookeBook featuresfeaturesfeaturesfeatures

With the Flipping-Book-Maker ebook you have created, your user will be

able to:

1. Click left button of the mouse to experience the page flip feeling.

2. Click button, link, and text on pages to go to product or order web pages.

3. Drag the corner or page frame to flip pages.

4. Find the pages from thumbnail quickly.

5. Input password to unlock encrypted pages.

6. Single/Double Page view.

7. View with pre-loading needed pages to open quickly; do not need to wait all

pages loaded.

8. Use button to control page, such as Previous, Next, First, Last etc.

9. Flip pages automatically.

10. View flipbook repeatedly.

11. View page flipping ebook full screen.

12. Search whole eBook.

13. Print out the whole ebook or a range of pages directly (support to clip area on

pages and then print).

14. Download the uploaded Flipping-Book-Maker eBook from web site directly.

15. Double-click to zoom in or zoom out.

16. Zoom in/ out both pages.

17. Share eBook URL via email.

18. Open or close page-turning sound.

19. Open to a certain page in Browser by adding a suffix like this:

index.html?pageIndex=4.

20. View output Flipping-Book-Maker eBook on iPad, iPhone and Android devices

(slide single pages mode supported).
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QuickQuickQuickQuick StartStartStartStart

1. Launch the application via the desktop shortcut ;

2. Click the "Import" icon to enter into Import PDF interface;

3. Click icon to choose PDF file from your computer;

4. Click icon to enter into template setting interface;

5. Edit shopping page objects, define parameters for eBooks, such as

Book, Tool Bar, Bookmarks, and then click the "Apply Change" icon ;

6. Click "Convert to Flipping Book" icon to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take

as example;

8. Click to set Output Folder as "C:\flipbook", input File Name

as "demo";

9. At last, click icon to output created Flipping-Book-Maker

eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:
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Open the "demo.html" file to view your created p00age-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

InterfacesInterfacesInterfacesInterfaces

There are some main interfaces you will see while using Shopping

Catalog to Flipping Book as below shows: ApplicationApplicationApplicationApplication OptionsOptionsOptionsOptions, ImportImportImportImport

PDFPDFPDFPDF, TemplateTemplateTemplateTemplate SettingsSettingsSettingsSettings, EditEditEditEdit PagesPagesPagesPages, LanguageLanguageLanguageLanguage OptionOptionOptionOption, ExportExportExportExport ThemeThemeThemeTheme,

OutputOutputOutputOutput, BatchBatchBatchBatch ConvertConvertConvertConvert and CommandCommandCommandCommand LineLineLineLine....

You can enter into each page to get clear instructions for every detail

option.
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I.I.I.I. ApplicationApplicationApplicationApplication OptionsOptionsOptionsOptions InterfaceInterfaceInterfaceInterface

1.1.1.1. RenderRenderRenderRender EngineEngineEngineEngine OptionOptionOptionOption

Shopping Catalog to Flipping Book provides 3 different render engines for you to
create higher quality Flipping-Book-Maker eBooks (change option when PDF
imported failed), click "Options->Application Options" to enter into "Render Engine"
interface:
SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

2.2.2.2. CreateCreateCreateCreateMobileMobileMobileMobile VersionVersionVersionVersion OptionOptionOptionOption

(1)(1)(1)(1) PagesPagesPagesPages QualityQualityQualityQuality andandandand SizeSizeSizeSize
Five types of "Pages Quality And Size" for mobile version eBooks:
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(2)(2)(2)(2)MobileMobileMobileMobile TemplateTemplateTemplateTemplate
The current version provides two mobile template modes for you to use: Slide and
Single Page Flip. The later one adds Flipping-Book-Maker effect on the pages while
viewing in mobiles.

II.II.II.II. ImportImportImportImport PDFPDFPDFPDF InterfaceInterfaceInterfaceInterface

1.1.1.1. SourceSourceSourceSource PDFPDFPDFPDF File:File:File:File:

Click this icon to open the PDF file you want to convert;

View content of added PDF file to clarify before converting.

2.2.2.2. TheTheTheThe PagePagePagePage RangesRangesRangesRanges totototo Import:Import:Import:Import:

Convert all pages to Flipping-Book-Maker eBook;

Convert defined range page;

Just preview effect on first 10 pages.
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3.3.3.3. WatermarkWatermarkWatermarkWatermark

Add image or text watermark to flipping pages.

Check this option first to choose default stamps or add new ones:

4.4.4.4. PagePagePagePage QualityQualityQualityQuality
There are five types of "Quality And Size":

5.5.5.5. OtherOtherOtherOther Options:Options:Options:Options:

If your PDF file contains bookmarks, check this option to use in output

Flipping-Book-Maker eBook;

If your PDF file has links, check this to enable in flipbook;

Check this option to enable search functionality in created flipbook.
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Check this option to make landscape page in PDF file to be presented as

two-page spread in output flipbook.

AtAtAtAt last,last,last,last, clickclickclickclick iconiconiconicon totototo enterenterenterenter intointointointo templatetemplatetemplatetemplate settingsettingsettingsetting interface.interface.interface.interface.

III.III.III.III.TemplateTemplateTemplateTemplate SettingsSettingsSettingsSettings InterfaceInterfaceInterfaceInterface

The design setting interface contains below main parts: ChooseChooseChooseChoose TemplateTemplateTemplateTemplate,,,, ToolToolToolTool BarsBarsBarsBars
Settings,Settings,Settings,Settings, FlashFlashFlashFlash DisplayDisplayDisplayDisplay SettingsSettingsSettingsSettings andandandand FlashFlashFlashFlash ControlControlControlControl Settings.Settings.Settings.Settings.

1.1.1.1. ChooseChooseChooseChoose TemplateTemplateTemplateTemplate

Click icon to select templates from below interface:
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Download more themes from PageFlipping now:
http://www.Flipping-Book-Maker.com/templates-themes/theme.html .

Click this icon is to save current settings as a TXT file for later uses;

Click this icon is to import stored setting file at once.

2.2.2.2. ToolToolToolTool BarBarBarBar SettingsSettingsSettingsSettings

(1)(1)(1)(1) TitleTitleTitleTitle BarBarBarBar (only(only(only(only inininin FloatFloatFloatFloat template)template)template)template)

Customize book title and logo for showing on the top of your flipbook. You are enabled to
set the book title as HTML format text. For example: <a
href='http://www.Flipping-Book-Maker.com'
target='_blank'>Flipping-Book-Maker.COM</a> | <font color='#ff0000' size='14'>Red
Color</font>

http://www.pageflipping.com/templates-themes/theme.html
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(2)(2)(2)(2) ButtonsButtonsButtonsButtons BarBarBarBar

i. Home Button

You can add a home button to help reader to click and go to your website directly:

ii. About Button

Add About button to show the author, contact, book, company info:

Click "…" to enter into "About & Contact" edit interface:

After clicking the About button, you will view the About window by clicking the button:
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iii. Full Screen Button
To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option:

Then you can click icon to view flipbook in Full Screen, click icon or "Esc"

button to exit from the Full Screen.
Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,
you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):

iv. Help Config

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you
can define Help Content manually by inserting "Help Content File (image or SWF)", also
enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the
book to center->No", you can set "Show Help At First->Show" to display the Help Panel with
the Book as below:
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You can also click the button to view the same Help page in pop-up window.

v. Print Config

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

You can also click "Print Watermark File->…" button to choose image or SWF file from your
computer as watermark on printed out pages.

vi. Download Setting

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
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"http://www.Flipping-Book-Maker.com/flip-pdf/example/files/download/FlipPDFDemo.pdf"
or relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the
PDF to the same path).

Then readers can click the icon to download your uploaded PDF file directly.

vii. Sound

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " " icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

viii. Zoom Config

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by

the zoom in tool like this: . You can also set "Scroll

with mouse->Yes" to scroll zoom in page while moving mouse.

ix. Search

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon
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, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:

x. Share

You can share via emails, or just through Facebook, Twitter, Google, etc..

a. Share Button
If you want readers to share via Email, you can enable "Share" feature as below shows:

When the viewers click the share button , they will enter into the Email interface with

the link of your flipbook in the Email body.

b. Social Share
If you want your flipbook viewers to send the link to their friends or clients via Facebook,
Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your

flipbook for readers to send out your flipbook link
immediately:

The readers just need to click the "Social Share" button , then the below window will pop

up for them to choose share channel:
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xi. Auto Flip
To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button , the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

xii. Thumbnail Button

Show Thumbnail Button (set "Enable") to view page thumbnails of your book, or you can

Disable it to hide the button.

xiii. Single Page

If your book contains landscape pages, or the page content is different to read for the font is too

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon to

view pages one after another, then click "Double Page" icon to back to the normal book

reading mode.
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(3)(3)(3)(3) ToolToolToolTool BarBarBarBar onononon TopTopTopTop (only(only(only(only inininin FloatFloatFloatFloat template)template)template)template)
If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":

(4)(4)(4)(4) AddAddAddAdd IconsIconsIconsIcons SettingsSettingsSettingsSettings
If you want to add some other kinds of buttons which the program doesn't provide, you can click
"Add Icons Settings->…" to enter into "Icons Settings" interface to add new icons on tool bar:

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More
details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".)



ConvertConvertConvertConvert PDFPDFPDFPDF totototo DigitalDigitalDigitalDigital 3D3D3D3D ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog UtilityUtilityUtilityUtility
UserUserUserUser DocumentDocumentDocumentDocument

Copyright 2012 by Flipping-Book-Maker.com
- 20 -

(5)(5)(5)(5) ButtonButtonButtonButton IconsIconsIconsIcons
Define settings for the icons of the buttons:

i. Icon Color

ii. Icon File
Select the Tool Bar Button to replace with your own icon.

More details please view here:
http://www.Flipping-Book-Maker.com/support/how-to-replace-icons-on-flash-toolbar.htm

3.3.3.3. FlashFlashFlashFlash DisplayDisplayDisplayDisplay SettingsSettingsSettingsSettings

((((1111)))) RetainRetainRetainRetain thethethethe bookbookbookbook totototo centercentercentercenter

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for
embedding special background image, such as advertisement or company log.

(2)(2)(2)(2) LanguageLanguageLanguageLanguage

You can set language for showing tools or tips in your created flipbook, and here is the
specialized instruction page for setting the "Language Option".

http://www.flipbuilder.com/support/how-to-replace-icons-on-flash-toolbar.htm
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(3)(3)(3)(3) FontFontFontFont

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search
result panel, you can set font types and colors in Font Panel.

(4)(4)(4)(4) InitialInitialInitialInitial ShowShowShowShow (set(set(set(set inininin Float/Float/Float/Float/ SpreadSpreadSpreadSpread templates)templates)templates)templates)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails":

Then you will get flipbook shown with below initial interface:

(5)(5)(5)(5) BackgroundBackgroundBackgroundBackground ConfigConfigConfigConfig

i. Background Color:
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Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two
colors.

ii. Background Image (set in Classical and Spread templates):

Click the icon " " to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

iii. Background Image (set in Float template):

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right

(6)(6)(6)(6) FlashFlashFlashFlashWindowWindowWindowWindow ColorColorColorColor

This color will be applied on all flash windows, such as the book window, "Help" window,
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"Print" window and so on.

(7)(7)(7)(7) PagePagePagePage BackgroundBackgroundBackgroundBackground ColorColorColorColor

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

(8)(8)(8)(8) BookBookBookBook ProportionsProportionsProportionsProportions

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(9)(9)(9)(9) BookBookBookBookMarginsMarginsMarginsMargins

i. Book Margin (set in Classical Template):

"Book Margin" refers to the distance between the book and the toolbar.
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ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

(10)(10)(10)(10) PagePagePagePage ShadowShadowShadowShadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(11)(11)(11)(11) HideHideHideHide BookBookBookBook FrameFrameFrameFrame BarBarBarBar

If don’t want to show the book frame bar, choose “Yes” in this option.

(1(1(1(12222)))) RightRightRightRight totototo LeftLeftLeftLeft
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:
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(1(1(1(13333)))) HardHardHardHard CoverCoverCoverCover
If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

(1(1(1(14444)))) FlippingFlippingFlippingFlipping timetimetimetime

Sets page flipping time in seconds according to needs. (Recommended second value is 0.6)

(15)(15)(15)(15) PagePagePagePage NumberNumberNumberNumber
If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)".
For example, the first 3 pages are Table of Content pages with Roman page numbers, and
set Arabic page numbers from page 4, then you will get page number box like below:

(16)(16)(16)(16)MinimeMinimeMinimeMinime StyleStyleStyleStyle
To present Flipping-Book-Maker eBook pages directly without showing toolbar, especially when
you want to embed eBook into a small area in existing webpages, then you can use this "Minime
Style":
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The Minime Style will trigger when the Width or Height of the Flash Container is less than the
defined value. You can also always show the Flipping-Book-Maker eBook in Minime Style with
adding a parameter to your URL like this:
www.yourdomain.com/index.html?alwaysMinimeStyle=true .

4.4.4.4. FlashFlashFlashFlash ControlControlControlControl SettingsSettingsSettingsSettings

(1).(1).(1).(1). SecuritySecuritySecuritySecurity SettingsSettingsSettingsSettings

If you want to protect your flash books with passwords, you can click "…" icon to enter into
"Flash Security Config" interface:

Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4
algorithm to protect eBook pages, the eBook content pages will show nothing without
permission.)

(2)(2)(2)(2).... LinksLinksLinksLinks

http://www.yourdomain.com/index.html?alwaysMinimeStyle=true


ConvertConvertConvertConvert PDFPDFPDFPDF totototo DigitalDigitalDigitalDigital 3D3D3D3D ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog UtilityUtilityUtilityUtility
UserUserUserUser DocumentDocumentDocumentDocument

Copyright 2012 by Flipping-Book-Maker.com
- 27 -

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting
"Enable after Zooming in->Enable".

(3).(3).(3).(3). GoogleGoogleGoogleGoogle AnalyticsAnalyticsAnalyticsAnalytics

In the HTML output format, you can add statistics by using google analytics. You can get
more information about Google Analytics ID from http://www.google.com/analytics/ .

Besides,Besides,Besides,Besides, ExportExportExportExport ThemeThemeThemeTheme

If you want to save the current template settings as your own style template for later uses,
you can click "File->Export current settings as Theme" button to storing all current template
settings, include the background images, margin values, toolbar buttons and so on.
Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface. Download more themes from Flipping-Book-Maker now:
http://www.Flipping-Book-Maker.com/templates-themes/theme.html .

IV.IV.IV.IV. EditEditEditEdit PagesPagesPagesPages

Now you can use Shopping Catalog to Flipping Book to edit imported pages directly, no matter
you want to add shopping price, item, product detail photos slideshow, link, video, sound or

image file. Just click "Edit Pages" button to enter into the editing interface:

http://www.google.com/analytics/
http://www.flipbuilder.com/templates-themes/theme.html
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1.1.1.1. TextTextTextText ButtonButtonButtonButton

Click the icon and then draw a button on a page, then define properties in below panel:

Define Button Text, set link URL, there are many different action options, like Go to page, Open a
link, Call Javascript function, Open Flash window, Play Audio and Play Slideshow.

2.2.2.2. PricePricePricePrice IconIconIconIcon

Click "Price" icon to add price for products like this:

You can also edit the icon type yourself in Properties panel:
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3.3.3.3. AddAddAddAdd ProductProductProductProduct PhotosPhotosPhotosPhotos

Click "Product Photos" icon to add images to pop-up in slideshow format:

4.4.4.4. AddAddAddAdd ButtonButtonButtonButton fromfromfromfrom ResourcesResourcesResourcesResources
Shopping Catalog to Flipping Book also provides many nice and typical resources for you to use

on ebooks. Click icon to add the icons onto pages, you can also use your own icons:

5.5.5.5. AddAddAddAdd LinkLinkLinkLink

Click the icon and then draw a link box on the area you want to add link, then define

properties in below panel:
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You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make
sure the parameter you set in "Function" can be called in from HTML page.

Example:Example:Example:Example: Check "Call Javascript function" as action type, then input Function as
"testLightBox("Hello, this is a test"):

And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link
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Function"):

6.6.6.6. AddAddAddAddMovieMovieMovieMovie

Click icon and then draw a box like below on the page you want to insert FLV movie:

Then you can select and edit the movie in below panel (define video player skin color, play and
stop movie actions, etc.):

7.7.7.7. AddAddAddAdd ImageImageImageImage

Click icon to draw image box and then select image (.jpg, .png, .bmp), set Action Options:
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8.8.8.8. AddAddAddAdd SoundSoundSoundSound

Click the icon to draw sound box and then select sound file, set other options:

9.9.9.9. AddAddAddAdd FlashFlashFlashFlash

Click icon to insert SWF flash into your defined area of flipbook page:
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10.10.10.10. AddAddAddAdd ButtonButtonButtonButton

Click icon to draw an area for inserting your image or SWF button file with calling actions.

The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash
Window". The before three actions are the same with the actions in "Add Link", the "Open Flash
Window" can help you to play SWF Flash or FLV Video in the pop-up window:

11.11.11.11. AddAddAddAdd YouYouYouYou TubeTubeTubeTube VideoVideoVideoVideo

Click the icon and then draw a box on the page to insert You Tube video into pages directly.

You just need to define the video ID directly. For example the video link is:
http://www.youtube.com/watch?v=xKA6WIqjB7c, then the video ID is "xKA6WIqjB7c".
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12.12.12.12. AddAddAddAdd PrintablePrintablePrintablePrintable AreaAreaAreaArea
If you want readers can click on some area of your book to print the area directly, such as
coupons which can be used to buy your presented goods, you can add a "Printable Area" on

pages by clicking the icon , and then draw the area on the pages, set title and description:

13.13.13.13. CopyCopyCopyCopy andandandand PastePastePastePaste
If you want to add same links, images, videos, audios to different pages, you don't have to repeat
the "Link/Image/Video/Audio added" operations once and once again, just select the link object,

click the copy button and then go to the other page to click the paste button directly.

14.14.14.14. ApplyApplyApplyApply AllAllAllAll
If you want to use the same link, video, audio, image or button on all pages (or all odd, even
pages, or your customized pages), you can select the object and then click the Apply All

button , then define the apply page range in pop-up window like below:

After adding links, flash, movie or sounds, you can click the icon to save the settings and

back to the template setting interface.
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V.V.V.V. LanguageLanguageLanguageLanguage OptionsOptionsOptionsOptions InterfaceInterfaceInterfaceInterface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

You can also add other language for your own uses:

1. Click the button and define name for the new language:

Click "OK" to save the new language in the list;
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2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":

3. At last, you can get all Labels translated into your new language as the images shows:

You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

Load language file saving before for current using:

After setting template and language, click icon to apply

the settings.
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VI.VI.VI.VI. OutputOutputOutputOutput InterfaceInterfaceInterfaceInterface

Output types:

1.1.1.1. HTMLHTMLHTMLHTML

This output type is for uploading created Flipping-Book-Maker ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Set Keywords, Description or even Script in the below interface:
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2.2.2.2. ZIPZIPZIPZIP

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon:

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

3.3.3.3. EXEEXEEXEEXE

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

You can also define Icon and Opening Window Size in Advanced Settings:
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4.4.4.4. APPAPPAPPAPP

If you want to make executable application to run on Mac devices, you can output as
"*.app" format.

5.5.5.5. MobileMobileMobileMobile VersionVersionVersionVersion

You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,
"files" and "mobile" folders), then you can visit the flipbook page through your mobile
browser.

6.6.6.6. BurnBurnBurnBurn totototo CDCDCDCD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
"Disc title".

How to make created eBooks available for others online, more details this support page:
http://Flipping-Book-Maker.com/support/how-can-i-share-my-created-ebook-online.htm .
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AAAAtttt lastlastlastlast clickclickclickclick buttonbuttonbuttonbutton totototo outputoutputoutputoutput flipbookflipbookflipbookflipbook inininin youryouryouryour defineddefineddefineddefined type.type.type.type.

VII.VII.VII.VII. BatchBatchBatchBatch ConvertConvertConvertConvert InterfaceInterfaceInterfaceInterface

1.1.1.1. AddAddAddAdd PDFPDFPDFPDF DocumentsDocumentsDocumentsDocuments

Click this icon to add PDF files from computer;

Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

2.2.2.2. SettingsSettingsSettingsSettings

(1).(1).(1).(1). OutputOutputOutputOutput SettingsSettingsSettingsSettings

i. Choose Output Type

ii. Choose Output Path
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You can also define output name pattern with FileName, Title, Subject and so on:

And after defining the File Name, you can preview the result example below:

iii. Define Output Option

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:

iv. Merge All PDF Files to One Flip Book

(2).(2).(2).(2). PDFPDFPDFPDF SettingsSettingsSettingsSettings

i. Page Range
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You can convert "All pages" or just "Custom range";

ii. Watermark

Click "Set Watermark" icon to enter into "Watermark" interface:

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

Choose quality and size type from listed five kinds.

iv. Other Options

If your PDF file contains bookmarks, check this option to use in output

Flipping-Book-Maker eBook;

If your PDF file has links, check this to enable in flipbook;

Check this option to enable search functionality in created flipbook.
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AtAtAtAt last,last,last,last, clickclickclickclick iconiconiconicon totototo batchbatchbatchbatch convertconvertconvertconvert listedlistedlistedlisted filesfilesfilesfiles together.together.together.together.

VIII.VIII.VIII.VIII. UseUseUseUse ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog totototo FlippingFlippingFlippingFlipping BookBookBookBook inininin CommandCommandCommandCommand LineLineLineLine

YouYouYouYou cancancancan alsoalsoalsoalso useuseuseuse ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog totototo FlippingFlippingFlippingFlipping BookBookBookBook inininin CommandCommandCommandCommand Line.Line.Line.Line.

Shopping Catalog to Flipping Book Command Line Usage:

PTCMD.exe [Options]

-f<PDF File> The source PDF file.

-o<output folder> Specify the folder for the output files.

-t[html|zip|exe] Output type. Default is html.

-n<OutputFileName> Specify the name for the output file.

-c<caption> Caption for HTML or EXE.

-s<Flash settings> Value format is:<Template name>#[<Theme name>|
<txt_settingfile path>].
<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.
<txt_settingfile path> is the file that you export
with "Save the template settings" function

-r<page range>. The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,or All.(Default: All)

-q<import quality> Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

-R<GS|SWF|LIB> Render engine options. (Default: GS, Ghostscript render
engine)

-b<Y|N> Import bookmark yes or no. (Default: Y)

-l<Y|N> Import links yes or no. (Default: Y).



ConvertConvertConvertConvert PDFPDFPDFPDF totototo DigitalDigitalDigitalDigital 3D3D3D3D ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog UtilityUtilityUtilityUtility
UserUserUserUser DocumentDocumentDocumentDocument

Copyright 2012 by Flipping-Book-Maker.com
- 44 -

-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)

-k<html key words> Set the keywords for html output file.

-d<html description> Set the descriptions for html output file.

-j<html javascript> Set the javascript for html output file.

-i<icon file path> Specify the icon path for exe output.

-w<window size> Specify the size of exe window.
Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -thtml -c"Title"

-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"

-c"Title" -s"Float#Blues" -r"All" -q5 -R"GS"

Examples 3:
PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -tzip -c"Title"

-s"Float#Blank" -r"All" -q5 -R"GS" -k"html key words"\

Return Code:
1: Success
2: Input file not found
3: Parameters are invalid
4: Failed to load PDF
5: Failed to import bookmarks
6: Failed to import links
7: Failed to import searchable information
8: Failed to save the output file.



ConvertConvertConvertConvert PDFPDFPDFPDF totototo DigitalDigitalDigitalDigital 3D3D3D3D ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog UtilityUtilityUtilityUtility
UserUserUserUser DocumentDocumentDocumentDocument

Copyright 2012 by Flipping-Book-Maker.com
- 45 -

LicenseLicenseLicenseLicense AgreementsAgreementsAgreementsAgreements

All copyrights to Shopping Catalog to Flipping Book (the Software) are exclusively owned by
Flipping-Book-Maker.com. For more information, visit our website at
www.Flipping-Book-Maker.com .

Anyone may use this software but all the Flipping-Book-Maker eBooks generated will
automatically have a demo watermark on the first page of them. To remove the limitation
you must register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHORWILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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HowHowHowHow totototo OrderOrderOrderOrder

Order Online
(http://www.Flipping-Book-Maker.com/shopping-catalog-to-flipping-book/index.html) or
Order Toll Free 1-877-353-7297 (When you order toll free just give the operator the product
number of the product you would like).

HowHowHowHow totototo purchasepurchasepurchasepurchase online?online?online?online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)

4. Check the information you filled previously and click "Place Secure Order"

OtherOtherOtherOther OrderOrderOrderOrderWaysWaysWaysWays————WithWithWithWith Phone/Mail/Fax/Check:Phone/Mail/Fax/Check:Phone/Mail/Fax/Check:Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100%100%100%100% unconditionalunconditionalunconditionalunconditional 30303030 DayDayDayDayMoneyMoneyMoneyMoney BackBackBackBack GuaranteeGuaranteeGuaranteeGuarantee

Want to custom the program or have other questions about purchase?
Contact us at support@Flipping-Book-Maker.com .

http://www/
mailto:support@page-flipping.com


ConvertConvertConvertConvert PDFPDFPDFPDF totototo DigitalDigitalDigitalDigital 3D3D3D3D ShoppingShoppingShoppingShopping CatalogCatalogCatalogCatalog UtilityUtilityUtilityUtility
UserUserUserUser DocumentDocumentDocumentDocument

Copyright 2012 by Flipping-Book-Maker.com
- 47 -

SupportSupportSupportSupport

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1.1.1.1. FrequentlyFrequentlyFrequentlyFrequently AskedAskedAskedAsked QuestionsQuestionsQuestionsQuestions

You can find answers to questions about technique issues here:
http://www.Flipping-Book-Maker.com/support

2.2.2.2. GetGetGetGet lostlostlostlost licenselicenselicenselicense codecodecodecode

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)
You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

3333.... ContactContactContactContact UsUsUsUs

If you have other questions or requirements, contact us directly through our support Email:
support@Flipping-Book-Maker.com, we will respond you ASAP.

http://www.regnow.com/cs/orderStatus
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